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This is how ILLUMINATED I felt when I figured out how to type statistical symbols in MS Word... the temple at Burning Man 2014. Image Credit: John David Tupper (photographerinfocus.com) I use Microsoft Word to prepare documents. I do not like Microsoft Equation Editor. And I have to type equations and expressions not often (like every
sentence or every other sentence), but definitely regularly. This has led me to apply what I like to call “agile shortcuts” — basically, I'll write down the equation in my own handwriting, take a picture of it, and then use a paint program to crop and clean up my equation before inserting it into my document. This works nicely, and even though some
people might think it’s a kludge, I kind of like the ability to retain the personality of my own handwriting in my technical documents. However, I don’t want to be embedding images if all I have to do is make reference to a variable within a paragraph of text... and I've never had a good solution. UNTIL THIS MORNING when I really, really, really
wanted to be able to use y-bar and p-hat in my paragraph, without having to do the even kludgier thing where you just call them “y-bar” and “p-hat” in the text. That doesn’t feel good. Even Arial Unicode MS, the behemoth of fonts (it even contains tons of Chinese, Japanese, and Korean characters) does not have essential statistical symbols. But turns
out, it DOES have this very useful capability called “combining diacritics” — and here’s how you can use it to type characters with their own hats and bars on them. How to Do It Open up Microsoft Word Choose “Arial Unicode MS” as your font First, type in a letter that you want to adorn with a hat. Say, for example, p. Next, go to Insert -> Symbol,
drop down to “More Symbols”, and in the window that pops up, make sure you have selected “Arial Unicode MS” as the font. In the bottom right, you’ll see a text area and a dropdown. To the right of the text area labeled “Character code:” type in 0302. That’s the code for a hat-on-top-of-a-letter. Going further right, there’s a dropdown that says
“from:” and you’ll want to make sure that you see “Unicode (hex)” selected in that box. Click “Insert”. Voila, your p has a hat!! Now, type a few spaces and let’s do this again. Only now, type in a letter that you want to adorn with a bar. Say, for example, x. Next, go to Insert -> Symbol, drop down to “More Symbols”, and in the window that pops up,
make sure you have selected “Arial Unicode MS” as the font. In the bottom right, you'll see a text area and a dropdown. To the right of the text area labeled “Character code:” type in 0305. That’s the code for a bar-on-top-of-a-letter. Going further right, there’s a dropdown that says “from:” and you’ll want to make sure that you see “Unicode (hex)”
selected in that box. Click “Insert”. Voila again! Your x has a bar. Go forth into the world and enjoy the same liberation I have just felt... o, ye writers of statistical stuff in documents. p q X y How do I type statistical symbols like X-Bar (X) in Excel. I also would like to type Y-Bar, d-bar, and p-hat. I am using Mac Excel 16.29.
Thanks, eddiev10025 Few ways to do it... 1. Type whatever the character you want in cell. Go to Insert ribbon tool -> Symbols -> Symbol. Set Font to Arial Unicode MS. For Character code: for bar, use 0305, for hat use 0302. Hit insert. It will combine whatever character you typed with the diacritical marks. 2. Use Insert -> Symbols -> Equation.
Enter your equation, using Accent to add Bar/Hat, while having character highlighted. Note that this will be shape object and not in cell. 3. My preferred method in most cases. Have list in UTF-8 text file. Copy and paste as needed. If it is of interest, both the combing overline and the combining macron work as valid Excel names. I have used X1 and x>
together for stats tests. Care needs to be taken to be sure to distinguish between x (overline) and x (macron) since, to Excel, they are completely different names. You can also insert symbols and special characters into Excel using your keyboard’s number pad. To do so, hold down the Alt key then enter the corresponding Alt character code on the
number pad. Here are a few examples of Alt code shortcut keys: Alt + 1 inserts a smiley symbol ® Alt + 3 inserts a heart symbol ¥ If you do not have a number pad, you can input Alt codes using the Windows on-screen keyboard. 1. Press the Windows key + Ctrl + O to open the on-screen keyboard. The mouse is used to press keys on the on-screen
keyboard. This means that you cannot press and hold Alt along with the digits on the on-screen keyboard’s number pad. Instead, you can lock the Alt key using Sticky Keys. 2. Press the Shift five times on your physical keyboard to turn on Sticky Keys. 3. Now you can lock the Alt key by pressing Alt on your physical keyboard twice. 4. With Alt locked,
enter the Alt character code on the number pad of the on-screen keyboard. For example, you can try entering 0-1-6-9. Alt + 0169 corresponds to the copyright symbol ©. 5. Press Alt again to release the Alt lock. Excel will then insert the symbol. You can browse through Alt character code lists available online like this one. Make sure to type the code
on the number pad exactly as shown. If an Alt character code has leading zeros, type the zeros in the number pad as well. Otherwise, the result may be different. Alternatively method You can also search for Alt character codes in the Windows Character Map: To open it: Press the Windows key + R > Type “charmap” > Hit Enter The keyboard
shortcut or Alt code of the selected character is shown at the bottom of the Character Map window. You can also use the Search field to find a special character using keywords. Now you know two different ways of inserting symbols into Excel. As you can see, it is fast and easy to use Alt shortcut keys. But this is only efficient if you have a number
pad with your keyboard. As for the built-in Symbols menu, you have to scroll through hundreds of available symbols. This can be tedious and dizzying & if you don’t already know where to look. So, this brings us to the easiest way of inserting symbols into Excel. Hi all, Trying to sort a chart where 2 sets of data are displayed with one set above zero
and the other below. So a bar with above and below the line. The problem is that I would like both sets to display positive. Easy to remove the '-' prefix from the labels, but not from the axis. So in effect I want £2,000,000 at the top and the same on the axis at the bottom without the zero. I have had to ensure the numbers were negative to get them
below the line, but then dealt with that issue with a a custom format code. Any thoughts on this much appreciated. Thanks, -CL Select the Chart Right click the Y-Axis and select Format Axis Select the Number Set the format code to #;#;0 Untick Linked to Source This is Excel 2016 Older versions will look different So simple but so useful!! Thank you

mathematical symbols on your documents. Unicode has a code point from 2200 to 22FF for mathematical operators. In addition, there are also many other mathematical symbols part of Unicode system like integrals, greater/less than, etc. You can use the decimal values of the Unicode points to use with the alt keys on Windows based documents.
Below is the complete list of alt code shortcuts for mathematical symbols. Drop in a comment, if you see some important symbol is missing. Alt + KeySymbolSymbol DescriptionCategory Alt + 969wSmall OmegaGreek Letter Alt + 961pSmall RhoGreek Letter Alt + 960nSmall PiGreek Letter Alt + 956puSmall MuGreek Letter Alt + 955ASmall
LamdaGreek Letter Alt + 951nSmall EtaGreek Letter Alt + 9486Small DeltaGreek Letter Alt + 947ySmall GammaGreek Letter Alt + 946BSmall BetaGreek Letter Alt + 945aSmall AlphaGreek Letter Alt + 937QCapital OmegaGreek Letter Alt + 934®Capital PhiGreek Letter Alt + 931XCapital SigmaGreek Letter Alt + 928I1Capital PiGreek Letter Alt +
9200Capital ThetaGreek Letter Alt + 916ACapital DeltaGreek Letter Alt + 915 Capital GammaGreek Letter Alt + 8967{Wavy LineOthers Alt + 8966 = PerspectiveOthers Alt + 8965 = ProjectiveOthers Alt + 8960zDiameterOthers Alt + 8925=Equals To Or Greater ThanEquals Alt + 8924=Equals To Or Less ThanEquals Alt + 8923=Greater Than Equals
To Or Less ThanEquals Alt + 89225Less Than Equals To Or Greater ThanEquals Alt + 8846wUnion With PlusUnion and Intersection Alt + 8809z Greater Than But Not Equals ToEquals Alt + 8808=Less Than But Not Equals ToEquals Alt + 8805=Greater Than Or Equals ToEquals Alt + 8804=<Less Than Or Equals ToEquals Alt + 8746UUnionUnion
and Intersection Alt + 8745NIntersectionUnion and Intersection Alt + 8726 \Left SlashOthers Alt + 8725/Right SlashOthers Alt + 8723FMinus Or PlusOthers Alt + 8722—Minus SignMinus Alt + 8709 Empty SetOthers Alt + 87060Partial DifferentialGreek Letter Alt + 8260/SlashDivision Alt + 61=EqualEquals Alt + 247-+DivisionDivision Alt +
215xMultiplication SignMultiplication Alt + 177xPlus Or MinusOthers Alt + 120539Bold Partial DifferentialGreek Letter Alt + 120538Bold Small OmegaGreek Letter Alt + 120532Bold Small SigmaGreek Letter Alt + 120530Bold Small RhoGreek Letter Alt + 120529Bold Small PiGreek Letter Alt + 120525Bold Small MuGreek Letter Alt + 120524Bold
Small LamdaGreek Letter Alt + 120520Bold Small EtaGreek Letter Alt + 120517Bold Small DeltaGreek Letter Alt + 120516Bold Small GammaGreek Letter Alt + 120515Bold Small BetaGreek Letter Alt + 120514Bold Small AlphaGreek Letter Alt + 120512Bold Capital OmegaGreek Letter Alt + 120509Bold Capital PhiGreek Letter Alt + 120506Bold
Capital SigmaGreek Letter Alt + 120503Bold Capital PiGreek Letter Alt + 120495Bold Capital ThetaGreek Letter Alt + 120491Bold Capital DeltaGreek Letter Alt + 120490Bold Capital GammaGreek Letter Alt + 10870Three EqualsEquals Alt + 10869Two EqualsEquals Alt + 10866Plus Sign Above Equals SignPlus Alt + 10832Closed Union With Serifs
And Smash ProductUnion and Intersection Alt + 10831Double Square UnionUnion and Intersection Alt + 10830Double Square IntersectionUnion and Intersection Alt + 10829Closed Intersection With SerifsUnion and Intersection Alt + 10828Closed Union With SerifsUnion and Intersection Alt + 10827Intersection Beside And Joined With
IntersectionUnion and Intersection Alt + 10826Union Beside And Joined With UnionUnion and Intersection Alt + 10825Intersection Above Bar Above UnionUnion and Intersection Alt + 10824 Union Above Bar Above IntersectionUnion and Intersection Alt + 10823Intersection Above UnionUnion and Intersection Alt + 10822Union Above
IntersectionUnion and Intersection Alt + 10821Union With Logical OrUnion and Intersection Alt + 10820Intersection With Logical AndUnion and Intersection Alt + 10819Intersection With OverbarUnion and Intersection Alt + 10818Union With OverbarUnion and Intersection Alt + 10817Union With MinusUnion and Intersection Alt +
10816Intersection With DotUnion and Intersection Alt + 10815AmalgamationOthers Alt + 10811Multiplication Sign in TriangleMultiplication Alt + 10810Minus SIGN IN TRIANGLEMinus Alt + 10809Plus Sign In TrianglePlus Alt + 10808Circled Division SignDivision Alt + 10807Multiplication Sign In Double CircleMultiplication Alt + 10806Circled
Multiplication Sign With Circumflex AccentMultiplication Alt + 10805Multiplication Sign In Right Half CircleMultiplication Alt + 10804Multiplication Sign In Left Half CircleMultiplication Alt + 10803Smash ProductMultiplication Alt + 10802Semidirect Product With Bottom ClosedMultiplication Alt + 10801 Multiplication Sign With
UnderbarMultiplication Alt + 10800Multiplication Sign With Dot AboveMultiplication Alt + 10798Plus Sign In Right Half CirclePlus Alt + 10797Plus Sign In Left Half CirclePlus Alt + 10796Minus Sign With Rising DotsMinus Alt + 10795Minus Sign With Falling DotsMinus Alt + 10794Minus Sign With Dot BelowMinus Alt + 10793Minus Sign With
Comma AboveMinus Alt + 10792Plus Sign With Black TrianglePlus Alt + 10791Plus Sign With Subscript TwoPlus Alt + 10790Plus Sign With Tilde BelowPlus Alt + 10789Plus Sign With Dot BelowPlus Alt + 10788Plus Sign With Tilde AbovePlus Alt + 10787Plus Sign With Circumflex Accent AbovePlus Alt + 10786Plus Sign With Small Circle AbovePlus
Alt + 10781]JoinOthers Alt + 10780[Lower Integrallntegrals Alt + 10779]Upper Integrallntegrals Alt + 10778§Integral With UnionIntegrals Alt + 107774Integral With IntersectionIntegrals Alt + 10776fIntegral With Times SignIntegrals Alt + 10775¢Integral With Leftwards Arrow With HookIntegrals Alt + 10774§Quaternion Integral
Operatorintegrals Alt + 10773§Integral Around A Point Operatorintegrals Alt + 10772 fLine Integration Not Including The Polelntegrals Alt + 10771 jLine Integration With Semicircular Path Around Polelntegrals Alt + 10770 fLine Integration With Rectangular Path Around Polelntegrals Alt + 10769fAnticlockwise IntegrationIntegrals Alt +
10768¢Circulation FunctionIntegrals Alt + 10767 fIntegral Average With SlashIntegrals Alt + 10766fIntegral With Double Strokelntegrals Alt + 10765fFinite Part Integrallntegrals Alt + 10764 ffffQuadruple Integral Operatorintegrals Alt + 10763Summation With Integrallntegrals Alt + 10762Modulo Two SumOthers Alt + 10747 #Triple PlusPlus Alt +
10746+#Double PlusPlus Alt + 10689Circled Greater ThanOthers Alt + 10688Circled Less ThanOthers Alt + 10684 Circled Rotated Division SignDivision Alt + 10683Circled Cross MarkMultiplication Alt + 10682Circled PerpendicularOthers Alt + 10679Circled ParallelOthers Alt + 10672Reversed Empty SetOthers Alt + 10655Acute AngleAngle Alt +
10653Right Angle With ArcOthers Alt + 10652Right Angle With SquareOthers Alt + 10624 Triple Vertical Bar DelimiterOthers Alt + 10135Bold DivisionDivision Also, learn how to type vulgar fractions with alt code shortcuts. There are multiple ways you can insert mathematical symbols in Windows 10/11. On Windows based documents, hold one of
the alt key on your keyboard and press the numbers in the first column of the above table. For example, alt + 177 will produce the plus or minus symbols like +. This will work on all Windows based Microsoft documents like Word, Excel and PowerPoint. However, you need to have a keyboard with number pad for using alt code shortcuts. If you don’t
have a keyboard with numeric keypad, then use the hexadecimal equivalent for the decimal numbers. You can type the hexadecimal numbers then press alt and x keys together. For example, 00F7 + alt + x will produce the division symbol like +. However, this method will only work on Microsoft Word documents. Microsoft introduced emoji keyboard
in Windows 10 to quickly insert emoji symbols in your documents. Later, with version 1903 the keyboard has been updated to include kaomoji and special symbols. With Windows 11, you can simply select “Symbols” icon and then look under “Math Symbols” to insert them in few clicks. This includes fractions, enclosed numbers, roman numerals and
all other math symbols. Select Symbols Category Math Symbols in Windows Emoji Panel Press “Win +.” or “Win + ;” keys to open emoji keyboard. Click on the symbol and then on the infinity symbol. Look for relevant math symbol to insert on your document. You can also use the Symbol utility in all Office documents like Word, Excel and PowerPoint
to insert math symbols. When you are in the document, go to “Insert > Symbols” menu to open “Symbol” utility. Change the font to “Symbol” and look for mathematical symbol to insert on your document. Mathematics Signs in Symbol Utility The last option is to use the independent Character Map app. You can search for Character Map in Windows
Search and open the app. Change the font to “Symbol” and find the math symbols as shown in the below picture. Double click on the symbol to select and then click “Copy” button to copy to clipboard. You can insert the copied symbol anywhere on your documents. Math Symbols in Character Map You can use the above shortcut methods to insert few
math symbols. However, when you want to insert a complex equations, you need to use the “Equation” option instead of using symbols. When you are in Office document, go to “Insert > Equation” menu. Choose the type of the equation and type accordingly. Typing Equations in Excel In addition to typing equations, you can also select the math
symbols from different categories like Basic Math, Greek Letters, Letter-Like Symbols, Operators, Arrows, Negated Relations, Scripts and Geometry. Select Math Symbols in Equation On Mac, you can use the hexadecimal code values with alt or option keys to type mathematical symbols. For example, option + 2A76 will produce the three equal
symbols like . You should change the keyboard input to Unicode Hex Input for using alt codes in Mac. The other easy way on Mac is to use the Character Viewer app. Press, “Control + Command + Spacebar” to open Character Viewer app. Go to Math Symbols section and insert the symbol you want. The biggest advantage of this method is that you
can choose hundreds of variations for each math symbol. Type Math Symbols Using Character Viewer in Mac The math symbols typed using the alt code shortcuts, Symbol utility and Character Map are like a text characters. You can change the size and format these symbols similar to any other text content on your documents. This is same for using
option code shortcuts in Mac and Character Viewer app. Especially, you can choose many font variations of math symbols in Character Viewer app. When you use equations, the symbols will behave like text boxes inside your document. You need to manually align the position and line height of the equations to match with other text content. Also, the
equations will become unreadable or converted to images when you change the document formats. Therefore, avoid using equations for smaller needs and use superscript, subscripts and math symbols using other explained options. You can download the below image by right clicking and saving to your computer for offline reference. Alt Code
Shortcuts for Maths Symbols Tags: Alt CodeKeyboardSymbolsUnicode Whether you were a stats lover (or a not-so-stats-lover) during school times, it is going to follow you everywhere.Common symbols from stats include letters or sometimes characters combined with a bar or a hat. Remember some symbols from that looked like below.That’s what we
call the P-hat symbol (notice the triangular hat above P). It is often used to represent the sample proportion.Insert a Bar Symbol In Excellnsert a Hat Symbol in ExcelConclusionJust like P-hat, the symbol below is called the Y-hat symbol. It represents the predicted value of the dependent variable (y).Similarly, stats would offer you a variety of such
symbols with a hat on the top like p-hat, r-hat, and x-hat, etc.Done with the caps - here is the X-bar symbol (with a bar on top of x). It represents the mean of a distribution.Not only X-bar, but you’d see many other symbols like the Y-bar, m-bar, etc.After we have revisited some of our statistical symbols, let us now see if you can insert these in Excel.
Don’t go searching for your keypad already; you won’t find them there. However, you can still add them to your spreadsheet.How? Let’s go straight into the tutorial below to learn that.The bar symbol is represented by a bar () on top of a letter. For example, an X-bar looks like a bar on top of the letter “x”.Symbols with a bar on the top often
represent the mean of a given data distribution (or averages). It is commonly used in statistics, and you’d need it in Excel for a variety of purposes. Like writing up statistical formulas, functions, or sometimes, signs.As these symbols are not readily available on your keypad or in Excel, you’d have to follow a quick science to have them in your
spreadsheet.This section will teach us how to add a bar symbol on the top of a letter/character in Excel. TIP! Some of the most commonly used bar symbols of Excel are produced below. If in a rush, simply copy them from here and paste them into your spreadsheet!Need a longer-term solution? Continue reading to learn how you can insert these in
Excel.Activate a cell in your spreadsheet and insert the character on top of which you need a bar inserted.We will use the “x” letter in this example to achieve the x-bar symbol.Select the cell (where “x” is typed).Go to the Insert tab > Symbols.Against the Font, select Normal Text.Against the subset, select Combining Diacritical Marks.Find the top bar
from the symbols and select itTIP! Hard to find the bar symbol? Type in 0305 in the Character Code box below - the symbol dialog box will automatically select it for you. Hit Insert to have the symbol inserted in the selected cell. In the image below, the bar symbol is added on top of “x”.That way, we have the X-bar symbol created in Excel.What if you
don’t need the x-bar but other symbols like the R-bar of the Y-bar? Just change the character in the cell before you perform the above steps.Add a bar to the top of each letter following the same steps as above to create any bar symbol as below.Doesn’t that make adding X-bar and other related symbols in Excel easy!The Hat symbol looks like an up-
headed triangle “~”. It is mostly used to represent an estimated or predicted value.Y-hat represents the predicted value of the dependent variable in an equation. How do you achieve hat-based symbols in Excel?The easiest and shortest way might be to copy and paste them from below simply.However, this method might not suit you the best if you
need to insert hat-based symbols in your spreadsheets quite often.To learn how you can add the hat symbol in Excel, follow these steps.Activate a cell in your spreadsheet and insert the character on top of which you need the hat symbol inserted.Let’s just use the letter “y” for now to achieve a Y-hat.Select the cell (where “Y” is typed).Go to the Insert
tab > Symbols.Against the Font, select Normal Text.Against the subset, select Combining Diacritical Marks.Find the hat symbol from the symbols and select itTIP! Type in the character code 0302 in the Character Code box below if you cannot find the hat symbol otherwise.Hit Insert to have the symbol inserted in the selected cell.In the image below,
the hat symbol (*) is added on top of “y”.And so, we have the Y-hat symbol ready in Excel.Using the same steps as above, you can literally create any hat-based symbol like P-Hat, r-hat, x-hat, you name it.Creating statistical symbols in Excel is not as difficult as it looks like it'd be, right?The guide above summarizes different methods of how you can
add the X-bar and Y-hat symbols in Excel. Using the same methods, you can create any kind of bar or hat-based symbols.And why only bar or hat symbols? Following the steps above, you can add any symbol (with any character) in your spreadsheet. Practice adding these symbols a couple of times and soon you will be able to insert them with your eyes
closed.Continue learning and go on spreadsheeting seamlessly! The X Bar symbol is used in statistics frequently. Method 1 - Use Symbol Command to Write X Bar in Excel Steps: Select the cells where you want to write the X Bar. (In the example below, the selected range is C4:C8). Go to the Home tab from the Ribbon. Click on the drop-down option
for Font. Select Arial as the Font. Select cell C4 and write X. Go to the Insert tab and select Symbol. The Symbol dialog box will appear. Select the drop-down option for Font and select Arial. Click on the drop-down option for Subset. Select Combining Diacritical Marks. Select Combining Overline and press Insert. Select Close in the dialog box. The X
Bar Symbol will show in the selected Excel cell (In the below example cell C4). To write the Y Bar follow the same steps above. To write multiple Bars select the cells where you want to write Bars. Go to the Home tab and click on the drop-down option for Fill. Click on the Flash Fill Options. Select Accept suggestions. The Bar symbol’s will appear
within the selected cells (in the below example cells C5 to C8). Read More: How to Insert Sign in Excel Formula Method 2 - Employ the Equation Feature to Insert X Bar in Excel Steps: Go to the Insert tab and select Equation. Select Accent from the Equation tab. Select Bar from the drop-down menu. The equation box will appear. Write X or the letter
you want. Double-click on the X Bar. Select Italic to remove the italic font from the X Bar. Click and drag the X Bar where you want it to be. The X Bar will shown in selected cell (in the below example shown in cell C4). For the remaining data, repeat these steps using the letters Y, P, M, Z or as required. Method 3 - Copy and Paste X Bar from Browser
to Write in Excel Steps: Search for the X Bar symbol in your browser (in the below example Google is shown). Select the symbol and copy it by pressing Ctrl + C on your keyboard. Select the cell where you want the X Bar. Here, I selected cell C4. Paste the X Bar in the formula bar by pressing Ctrl + V on your keyboard. Press Enter and you will get
the X Bar. Write bars for other letters in the same way. Read More: How to Insert Symbol in Excel Footer Method 4 - How to Write P Hat in Excel The Symbol feature will be used for this section. Steps: Select the cells where you want to write the symbols. Go to the Home tab. Select Arial as the Font. Select the cell where you want to write P Hat.
Write P in the selected cell. Go to the Insert tab. Select Symbol. The Symbol dialog box will appear. Select Arial as Font. Choose Combining Diacritical Marks as the Subset. Select Combining Circumflex Accent and press Insert. You have now written P Hat in Excel Write the other symbols by following the steps from Method 1. Practice Section Here’s
a sheet you can use to practice writing X Bar in Excel Download Practice Workbook You can download the practice workbook from here. Related Articles



